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About PPT to Flash Catalog 

Often design 

presentations) 

PPT to Flash Catalog 

more effective 

consulting quality documents.

Flash Catalog  

presentations into Flash

real page-flipping animation and sound. 

you are enabled to add many kinds of objects into 

PPT slides, MP4

music audios, hyperlinks, email addresses, internal 

page links, image slideshow

interactive and wonderful feeling to your 

presentations! 

 

 

 

 

 

 

Note: This product is distributed on a "Try before

basis. All features described in this documentation are 

enabled. The registered version doesn't insert a waterma

your generated page
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PPT to Flash Catalog  Pro 

design PowerPoint documents (reports, 

 for business or personal purpose? 

PPT to Flash Catalog  Professional will 

effective and amazing elements to produce 

consulting quality documents. The software 

 Pro is helping you to convert PPT 

presentations into Flash based publications, with 

flipping animation and sound. Moreover, 

you are enabled to add many kinds of objects into 

, MP4, FLV movies, YouTube videos, MP3 

music audios, hyperlinks, email addresses, internal 

page links, image slideshow and so on. Bring more 

interactive and wonderful feeling to your 

 

Note: This product is distributed on a "Try before

basis. All features described in this documentation are 

enabled. The registered version doesn't insert a waterma

your generated page-flipping eBooks. 
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uments (reports, 

or personal purpose? 

 give you 

elements to produce 

The software PPT to 

is helping you to convert PPT 

based publications, with 

Moreover, 

you are enabled to add many kinds of objects into 

, FLV movies, YouTube videos, MP3 

music audios, hyperlinks, email addresses, internal 

nd so on. Bring more 

interactive and wonderful feeling to your 

Note: This product is distributed on a "Try before-you-buy" 

basis. All features described in this documentation are 

enabled. The registered version doesn't insert a watermark in 
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Product features

1. Convert PPT to Adobe© Flash® based page

2. Batch convert multiple 

3. Import bookmarks (outline) with 

4. Import hyperlinks with 

5. Import text so text is searchable, define the minimum search characters.

6. Define image or text more, 

7. Output in different formats: HTML, EXE, Zip, Mac App, Mobil

to CD. 

o HTML allows you to upload to a website to be viewed online (with title, 

keywords and other metadata defined).

o EXE (with setting title, icon and open window size) and Zip allow you to 

send to your user by email to be viewed on 

o App (Mac Application) is executable application can be run on Mac.

o Mobile version is to output HTML flipbook which can be viewed on mobile 

devices via Browsers.

o Burn to CD allows you to burn to disk so you can send your user physical 

media for viewing on their computer.

8. Apply a pre-designed template.

9. Preview the output effect instantly.

10. Add HTML Title in Float template which can be clicked to visit webpage online.

11. Add Image or Flash logo to insert before Book Title in Float template.

12. Define book proportions, margin size, shadow manually.

13. Replace existing icons on toolbar by editing Icon Flash file.
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Product features 

to Adobe© Flash® based page-flipping eBooks. 

Batch convert multiple PPT files to multiple page-flipping eBooks. 

Import bookmarks (outline) with PPT, and edit them manually. 

Import hyperlinks with PPT, include web link, page link, email link.

Import text so text is searchable, define the minimum search characters.

image or text more, quality and size for pages. 

Output in different formats: HTML, EXE, Zip, Mac App, Mobile version and Burn 

HTML allows you to upload to a website to be viewed online (with title, 

keywords and other metadata defined). 

EXE (with setting title, icon and open window size) and Zip allow you to 

send to your user by email to be viewed on their computer. 

App (Mac Application) is executable application can be run on Mac.

Mobile version is to output HTML flipbook which can be viewed on mobile 

devices via Browsers. 

Burn to CD allows you to burn to disk so you can send your user physical 

media for viewing on their computer. 

designed template. 

Preview the output effect instantly. 

Add HTML Title in Float template which can be clicked to visit webpage online.

Add Image or Flash logo to insert before Book Title in Float template.

efine book proportions, margin size, shadow manually. 

Replace existing icons on toolbar by editing Icon Flash file. 
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, include web link, page link, email link. 

Import text so text is searchable, define the minimum search characters. 

e version and Burn 

HTML allows you to upload to a website to be viewed online (with title, 

EXE (with setting title, icon and open window size) and Zip allow you to 

App (Mac Application) is executable application can be run on Mac. 

Mobile version is to output HTML flipbook which can be viewed on mobile 

Burn to CD allows you to burn to disk so you can send your user physical 

Add HTML Title in Float template which can be clicked to visit webpage online. 

Add Image or Flash logo to insert before Book Title in Float template. 
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14. Add new icons into toolbar with calling new actions.

15. Set background color and image.

16. Insert background music either for continuous play (loo

17. Set eBook reading from right to left (for Right

18. Choose hard cover for eBooks.

19. Set fonts for Flash and Bookmark

20. Set Page Number Box to show at top or bottom in Float, set start page

21. Edit pages with embedding

files. 

22. Add Button on pages to open link page, call Javascript action, play Flash/Video in 

pop-up Window. 

23. Copy projects from one page to another or all the other pages.

24. Define the language for your published page

multi-language show and switchable). 

25. Add password to protect your page

26. Different kinds of render engine for 

PPT files: SWF, GPL Ghostscript or Inner Library. 

27. Add Google Analytics Support.

28. Add watermark image or SWF to show on print out pages.

29. Add Help config to manually define content with using Image or SWF.

30. Add Single/Double Page view.

31. Add Minime Style to show page

32. Set permissions for downloading, printing, social sharing, Home, About button 

and more. 

33. Edit bookmark manually and set bookmark panel to show on left or right side.

34. Export and save settings for future uses.

35. Save and Load your project.
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Add new icons into toolbar with calling new actions. 

Set background color and image. 

Insert background music either for continuous play (loop) or for a set duration.

Set eBook reading from right to left (for Right-to-Left languages such as Arabic).

Choose hard cover for eBooks. 

Set fonts for Flash and Bookmark, Search panel. 

Set Page Number Box to show at top or bottom in Float, set start page

embedding links, images, movies, flash, sound or You Tube video

Add Button on pages to open link page, call Javascript action, play Flash/Video in 

Copy projects from one page to another or all the other pages. 

Define the language for your published page-flipping eBook (support 

language show and switchable).  

Add password to protect your page-flipping eBook. 

Different kinds of render engine for choice to avoid distortion for some special 

L Ghostscript or Inner Library.  

Add Google Analytics Support. 

Add watermark image or SWF to show on print out pages. 

Add Help config to manually define content with using Image or SWF.

Add Single/Double Page view. 

Add Minime Style to show page-flipping eBooks without toolbar. 

Set permissions for downloading, printing, social sharing, Home, About button 

Edit bookmark manually and set bookmark panel to show on left or right side.

Export and save settings for future uses. 

Save and Load your project. 
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p) or for a set duration. 

Left languages such as Arabic). 

Set Page Number Box to show at top or bottom in Float, set start page number. 

or You Tube video 

Add Button on pages to open link page, call Javascript action, play Flash/Video in 

flipping eBook (support 

to avoid distortion for some special 

Add Help config to manually define content with using Image or SWF. 

 

Set permissions for downloading, printing, social sharing, Home, About button 

Edit bookmark manually and set bookmark panel to show on left or right side. 
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Page-flipping eBook features

With the page-flipping ebook you have created, your user will be able to:

1. Show flip effect on the page corner at the very beginning.

2. Drag the corner to flip a page.

3. Click page shadows to flip a page.

4. Input password to unlock 

5. Single/Double Page view.

6. View with pre-loading needed pages to open quickly, do not need to wait all 

pages loaded. 

7. Use button to control page, such as Previous, Next, First, Last etc.

8. Flip pages automatically.

9. View flipbook repeatedly.

10. View page-flipping ebook full screen.

11. Use thumbnail to navigate.

12. Search whole eBook.

13. Print out the whole ebook or a range of pages directly (support to clip area on 

pages and then print).

14. Download the uploaded page

15. Double-click to zoom in or zoom out.

16. Zoom in/ out both pages.

17. Share eBook url via email.

18. Open or close page

19. Open to a certain page in Browser by adding a suffix like this: 

index.html?pageIndex=4.

20. View output page-

single pages mode supported)
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flipping eBook features 

flipping ebook you have created, your user will be able to:

Show flip effect on the page corner at the very beginning. 

Drag the corner to flip a page. 

Click page shadows to flip a page. 

Input password to unlock encrypted pages. 

Single/Double Page view. 

loading needed pages to open quickly, do not need to wait all 

Use button to control page, such as Previous, Next, First, Last etc.

Flip pages automatically. 

View flipbook repeatedly. 

flipping ebook full screen. 

Use thumbnail to navigate. 

Search whole eBook. 

Print out the whole ebook or a range of pages directly (support to clip area on 

pages and then print). 

Download the uploaded page-flipping eBook from web site directly.

click to zoom in or zoom out. 

Zoom in/ out both pages. 

Share eBook url via email. 

Open or close page-turning sound. 

Open to a certain page in Browser by adding a suffix like this: 

index.html?pageIndex=4. 

-flipping eBook on iPad, iPhone and Android devices

mode supported). 

Flipping eBook Utility 
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flipping ebook you have created, your user will be able to: 

loading needed pages to open quickly, do not need to wait all 

Use button to control page, such as Previous, Next, First, Last etc. 

Print out the whole ebook or a range of pages directly (support to clip area on 

flipping eBook from web site directly. 

Open to a certain page in Browser by adding a suffix like this: 

d Android devices (slide 
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Quick Start 

1. Launch the application via the desktop shortcut

2. Click the "Import PPT

3. Click icon to choose 

4. Click icon to enter into template setting interface;

5. Define parameters for eBooks, such as Book, Tool Bar, Bookmarks, and 

then click the "Apply Change" icon

6. Click "Convert to Flipping Book" icon 

interface; 

7. Choose Output Type from

as example;

8. Click to set Output Folder as "C:

as "demo"; 

9. At last, click

 
You can open the "flipbook" folder in "C:",

 

Open the "demo.html" file to view your created p

Browser, such as Internet Explorer, Google Chrome, Firefox, etc.
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Launch the application via the desktop shortcut ; 

PPT" icon  to enter into Import PPT

icon to choose PPT file from your computer;

icon to enter into template setting interface;

5. Define parameters for eBooks, such as Book, Tool Bar, Bookmarks, and 

then click the "Apply Change" icon ; 

6. Click "Convert to Flipping Book" icon to enter into Output 

7. Choose Output Type from HTML, ZIP and EXE, here take 

as example; 

to set Output Folder as "C:\flipbook", input File Name 

icon to output created page-flipping eBook.

You can open the "flipbook" folder in "C:", there are three files in this folder:

 

Open the "demo.html" file to view your created p00age-flipping book via Web 

Browser, such as Internet Explorer, Google Chrome, Firefox, etc. 

Flipping eBook Utility 

User Document 

PPT interface; 

file from your computer; 

icon to enter into template setting interface; 

5. Define parameters for eBooks, such as Book, Tool Bar, Bookmarks, and 

to enter into Output 

HTML, ZIP and EXE, here take 

flipbook", input File Name 

flipping eBook. 

there are three files in this folder: 

flipping book via Web 
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Interfaces 

There are some main interfaces you will see while using 

Catalog  Pro as below shows:

Pages, Export Theme

each page to get clear instructions for every detail option.

 

I. Import PPT Interface

Panel Description: 

PPT to Flash Catalog  Professional Flipping eBook Utility

User Document

Copyright 2012 by flashcatalogmaker.com 

- 6 - 

main interfaces you will see while using 

as below shows:, Import PPT, Template Settings

Export Theme, Output, and Batch Convert. You can enter into 

each page to get clear instructions for every detail option. 

Interface 

 

Flipping eBook Utility 

User Document 

main interfaces you will see while using PPT to Flash 

Template Settings, Edit 

You can enter into 
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1. Source PPT File:  

 Click this icon to open the 

 View content of added 

 

2. The Page Ranges to Import:

 Convert all pages to page

3. File Mode 

Two modes for your choice: 

4. Page Quality 

There are five types of "Quality And Size":

5. Other Options: 

 

If your PPT

page-flipping eBook; 

If your PPT

Check this option to enable search functionality in created flipbook.

 

At last, click 
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Click this icon to open the PPT file you want to convert; 

View content of added PPT file to clarify before converting. 

2. The Page Ranges to Import: 

Convert all pages to page-flipping eBook; 

Convert defined range page;

 Just preview effect on first 10 pages.

 

 

There are five types of "Quality And Size": 

 

PPT file contains bookmarks, check this option to use in output 

PPT file has links, check this to enable in flipbook; 

Check this option to enable search functionality in created flipbook.

 icon to enter into template setting interface.

Flipping eBook Utility 

User Document 

defined range page; 

first 10 pages. 

file contains bookmarks, check this option to use in output 

 

Check this option to enable search functionality in created flipbook. 

icon to enter into template setting interface. 
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II. Template Setting

 

PPT to Flash Catalog  Professional

Float and Spread. Each template contains some unique settings, the below instructions will 

show you details about the default three templates

below main parts: 

Choose Template, Tool Bars Settings, Flash Display Settings and Flash Control Settings.

 

1. Choose Template 

Click icon to select templates

(More themes: http://www.
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Template Settings Interface 

fessional provides 3 different templates in the program

Each template contains some unique settings, the below instructions will 

about the default three templates. The design setting interface contains 

Tool Bars Settings, Flash Display Settings and Flash Control Settings.

 

icon to select templates from below select interface:

http://www.flashcatalogmaker.com/alpha-templates.html.) 

 

Flipping eBook Utility 

User Document 

 
in the program: Classical, 

Each template contains some unique settings, the below instructions will 

The design setting interface contains 

Tool Bars Settings, Flash Display Settings and Flash Control Settings. 

select interface: 
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 Click this icon is to save current settings as a TXT file for later uses;

 Click this icon is to import stored setting file at once.

 

2. Tool Bar Settings 

 

(1) Title Bar (only in Float template)

Customize book title and logo for showing on the top of

set the book title as HTML format text. For example:

href='http://www.Flashcatalogmaker

| <font color='#ff0000' size='14'>Red Color</font>

(2) Buttons Bar 

 

i. Home Button 

You can add a home button
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Click this icon is to save current settings as a TXT file for later uses; 

Click this icon is to import stored setting file at once. 

 

Title Bar (only in Float template) 

 

Customize book title and logo for showing on the top of your flipbook. You are enabled to 

set the book title as HTML format text. For example: <a 

Flashcatalogmaker.com' target='_blank'>FLASHCATALOGMAKER

| <font color='#ff0000' size='14'>Red Color</font> 

 

 to help reader to click and go to your website directly:

Flipping eBook Utility 

User Document 

your flipbook. You are enabled to 

FLASHCATALOGMAKER.COM</a> 

to help reader to click and go to your website directly: 
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ii. About Button 

Add About button  to show the author, contact, book, company info:

Click "…" to enter into "About & Contact" edit interface

view the About window by clicking the button:

 

iii. Full Screen Button 

To enable "Full Screen" functionality in output flipbook, select "Show" in "Full Screen 

Button" option: 

Then you can click icon 

button to exit from the Full Screen.

Or if you want to show your flipbook without Tool Bar while showing in Full Screen mode, 

you can set "No" in "Full Screen without Tool Bar" (just in Classical Temp

 

iv. Help Config 

To show tips about viewing flipbook, you can set "Show" in "Help Button" option

can define Help Content manually by inserting "Help Content File (image or SWF)", 

enable to define the Width and Height of the Help im
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to show the author, contact, book, company info: 

 

" to enter into "About & Contact" edit interface, after clicking the About butto

the About window by clicking the button: 

To enable "Full Screen" functionality in output flipbook, select "Show" in "Full Screen 

 

 to view flipbook in Full Screen, click icon 

button to exit from the Full Screen. 

Or if you want to show your flipbook without Tool Bar while showing in Full Screen mode, 

you can set "No" in "Full Screen without Tool Bar" (just in Classical Temp

 

 

To show tips about viewing flipbook, you can set "Show" in "Help Button" option

can define Help Content manually by inserting "Help Content File (image or SWF)", 

enable to define the Width and Height of the Help image or swf. If you set "Book

Flipping eBook Utility 

User Document 

fter clicking the About button, you will 

 

To enable "Full Screen" functionality in output flipbook, select "Show" in "Full Screen 

to view flipbook in Full Screen, click icon  or "Esc" 

Or if you want to show your flipbook without Tool Bar while showing in Full Screen mode, 

you can set "No" in "Full Screen without Tool Bar" (just in Classical Template): 

To show tips about viewing flipbook, you can set "Show" in "Help Button" option, and you 

can define Help Content manually by inserting "Help Content File (image or SWF)", also 

age or swf. If you set "Book->Retain the 
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book to center->No", you can set "Show Help At First

the Book as below: 

You can also click the button 

 

v. Print Config 

Choose "Yes" in "Print Enable", then click icon 

You can also click "Print Watermark File

computer as watermark on printed out pages.

 

vi. Download Setting 

If you want your flipbook readers to download the 

website, select "Yes" in "Download Enable" option, then input the Download URL directly, 

you can use absolute path like 

"http://www.Flashcatalogmaker

or relative path like "/files/download/Flip

PPT to the same path). 
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>No", you can set "Show Help At First->Show" to display the Help Panel with 

 

the button  to view the same Help page in pop-up window.

 

Choose "Yes" in "Print Enable", then click icon  to set print page range as below:

 

You can also click "Print Watermark File->…" button to choose image or SWF file from your 

computer as watermark on printed out pages. 

  

If you want your flipbook readers to download the PPT file or the flipbook directly from your 

website, select "Yes" in "Download Enable" option, then input the Download URL directly, 

you can use absolute path like 

Flashcatalogmaker.com/flip-PPT/example/files/download/FlipPPT

or relative path like "/files/download/FlipPPTDemo.PPT" (make sure you have uploaded the 

Flipping eBook Utility 

User Document 

>Show" to display the Help Panel with 

up window. 

to set print page range as below: 

" button to choose image or SWF file from your 

file or the flipbook directly from your 

website, select "Yes" in "Download Enable" option, then input the Download URL directly, 

PPTDemo.PPT" 

" (make sure you have uploaded the 
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Then readers can click the icon 

 

vii. Sound 

If you want to add background sound to your flipbook, such as a song or other audio file, set 

"Enable Sound->Enable", then click "

then set "Sound Loops", "-1" stands for playing the sound file all the time while viewing

flipbook, other value (N>0) stands for the times of playing the sound file.

 

viii. Zoom Config 

To Enable Zoon In functionality, choose ''Yes" in "Zoon in enable", then set "Zoom Scale", the 

value is the times between zoomed page size and the current 

 

In Float template, you don't need to set Zoom Scale, you can adjust more conveniently by 

the zoom in tool like this: 

with mouse->Yes" to scroll zoom in page while 

 

ix. Search 

Select "Show" in "Search Button" (make sure you have check "Enable Search" option in 

"Import PPT" interface), then define "Search Highlight Color", after clicking "Search" icon 

, you will see a popup box to input search words, then click Enter or "Search"
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Then readers can click the icon  to download your uploaded PPT file directly.

 

add background sound to your flipbook, such as a song or other audio file, set 

>Enable", then click " " icon to choose "Sound File" from your computer, 

1" stands for playing the sound file all the time while viewing

flipbook, other value (N>0) stands for the times of playing the sound file. 

 

To Enable Zoon In functionality, choose ''Yes" in "Zoon in enable", then set "Zoom Scale", the 

value is the times between zoomed page size and the current page size. 

In Float template, you don't need to set Zoom Scale, you can adjust more conveniently by 

. You can also set "Scroll 

>Yes" to scroll zoom in page while moving mouse. 

 

Select "Show" in "Search Button" (make sure you have check "Enable Search" option in 

" interface), then define "Search Highlight Color", after clicking "Search" icon 

, you will see a popup box to input search words, then click Enter or "Search"

Flipping eBook Utility 
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file directly. 

add background sound to your flipbook, such as a song or other audio file, set 

" icon to choose "Sound File" from your computer, 

1" stands for playing the sound file all the time while viewing 

To Enable Zoon In functionality, choose ''Yes" in "Zoon in enable", then set "Zoom Scale", the 

In Float template, you don't need to set Zoom Scale, you can adjust more conveniently by 

. You can also set "Scroll 

Select "Show" in "Search Button" (make sure you have check "Enable Search" option in 

" interface), then define "Search Highlight Color", after clicking "Search" icon 

, you will see a popup box to input search words, then click Enter or "Search" button, 
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you will get the below searching result:

 

x. Share 

You can share via emails, or just through Facebook, Twitter, Google, etc..

a. Share Button 

If you want readers to share via Email, you can enable "Share" feature as below shows:

When the viewers click the share button

the link of your flipbook in the Email body.

 

b. Social Share 

If you want your flipbook viewers to send the link to their friends or clients

Twitter, Linkedin, Google, Yahoo and so on

flipbook for readers to send out your flipbook link immediately:

The readers just need to click the "Social Share" button

up for them to choose share channel
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you will get the below searching result: 

 

 

You can share via emails, or just through Facebook, Twitter, Google, etc.. 

If you want readers to share via Email, you can enable "Share" feature as below shows:

 

viewers click the share button , they will enter into the Email interface with 

the link of your flipbook in the Email body. 

If you want your flipbook viewers to send the link to their friends or clients

gle, Yahoo and so on, you can add a Social Share button in your 

flipbook for readers to send out your flipbook link immediately: 

 

The readers just need to click the "Social Share" button , then the below window will pop 

up for them to choose share channel: 

 

Flipping eBook Utility 

User Document 

If you want readers to share via Email, you can enable "Share" feature as below shows: 

, they will enter into the Email interface with 

If you want your flipbook viewers to send the link to their friends or clients via Facebook, 

hare button in your 

, then the below window will pop 
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xi. Auto Flip 

To auto flip your eBooks, you can set "Yes" in "Auto Flip

Flip Interval (seconds of staying on each page); the value of "Play Count" stands for the times 

of auto playing the eBook, and "

button , the flipbooks will be flipped by staying 3 seconds per page); if you want to 

auto start and flip the eBook after opening, just set "Auto flip when start up

 

xii. Thumbnail Button 

Show Thumbnail Button 

Disable it to hide the button. 

 

xiii. Single Page 

If your book contains landscape pages, or the 

small, you can set "Single Page

view pages one after another, then click "Double Page" icon 

reading mode. 

 

xiv. Language 

You can set language for showing tools or tips in your create

"Language Settings" interface:
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To auto flip your eBooks, you can set "Yes" in "Auto Flip->Enable" option; then define the 

Flip Interval (seconds of staying on each page); the value of "Play Count" stands for the times 

of auto playing the eBook, and "-1" stands for playing forever (after clicking the Auto Flip 

, the flipbooks will be flipped by staying 3 seconds per page); if you want to 

auto start and flip the eBook after opening, just set "Auto flip when start up-

 

 

(set "Enable") to view page thumbnails of your book, or you can 

 

 

your book contains landscape pages, or the page content is different to read for the font is too 

t "Single Page->Enable" to enable readers to click "Single Page" icon 

view pages one after another, then click "Double Page" icon  to back to the normal book 

 

You can set language for showing tools or tips in your created flipbook, click "

interface: 

Flipping eBook Utility 

User Document 

>Enable" option; then define the 

Flip Interval (seconds of staying on each page); the value of "Play Count" stands for the times 

ying forever (after clicking the Auto Flip 

, the flipbooks will be flipped by staying 3 seconds per page); if you want to 

->Yes": 

(set "Enable") to view page thumbnails of your book, or you can 

for the font is too 

>Enable" to enable readers to click "Single Page" icon  to 

to back to the normal book 

click "…" to enter into 
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As the tips explaining, the "Labeled" column lists the buttons and instructions on Flash books 

in defined language, and the program provides you 

English, Chinese, Arabic, French

You can choose two or more language to use, just check "Switchable" option, then users can 

click "Switch Language" button 

 

You can also add other language for your own uses:

 

1. Click the button  and define name for the new language:
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As the tips explaining, the "Labeled" column lists the buttons and instructions on Flash books 

in defined language, and the program provides you 10 different languages for you to use: 

Arabic, French, German, Greek, Hebrew, Italian, Japanese 

You can choose two or more language to use, just check "Switchable" option, then users can 

click "Switch Language" button to choose their prefer language for tips:

 

You can also add other language for your own uses: 

and define name for the new language: 

Flipping eBook Utility 

User Document 

As the tips explaining, the "Labeled" column lists the buttons and instructions on Flash books 

different languages for you to use: 

 and Portuguese. 

You can choose two or more language to use, just check "Switchable" option, then users can 

oose their prefer language for tips: 
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Click "OK" to save the new language in the list;

2. Choose the first label and click "Edit" icon, defi

then click "Save And Edit Next":

 

 

3. At last, you can get all Labels translated into your new language as the images shows:

You can delete unwanted language: 

Or save your edited new language file as XML or TXT file: 

Load language file saving before for current using: 
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Click "OK" to save the new language in the list; 

2. Choose the first label and click "Edit" icon, define new language text in "Labeled" box, 

then click "Save And Edit Next": 

 

3. At last, you can get all Labels translated into your new language as the images shows:

 

You can delete unwanted language:  

Or save your edited new language file as XML or TXT file:  

Load language file saving before for current using:  

Flipping eBook Utility 
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ne new language text in "Labeled" box, 

3. At last, you can get all Labels translated into your new language as the images shows: 
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(3) Tool Bar on Top (only in Float template)

If you want to place the toolbar in Float templates on the top of the flash eBook, you can set 

"Tool Bar on Top" as "True": 

 

(4) Add Icons Settings 

If you want to add some other kinds of buttons which the program doesn't provide, you can click 

"Add Icons Settings->…" to enter into "Icons Settings" interface to add new icons on tool bar:

You can define the link action as "Go to page", or open an online webpage, or even "Call 

Javascript function" to carry out your wanted interactive functionalities via defining Javascript 

function yourself.. After your "Apply Change

details about Call Javascript function will be introduced in the part of "Edit Page

 

(5) Button Icons 

Define settings for the icons of the buttons
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(3) Tool Bar on Top (only in Float template) 

If you want to place the toolbar in Float templates on the top of the flash eBook, you can set 

 

 

If you want to add some other kinds of buttons which the program doesn't provide, you can click 

" to enter into "Icons Settings" interface to add new icons on tool bar:

 

define the link action as "Go to page", or open an online webpage, or even "Call 

Javascript function" to carry out your wanted interactive functionalities via defining Javascript 

After your "Apply Change", the new added icon will show in the toolbar. (More 

details about Call Javascript function will be introduced in the part of "Edit Page-

Define settings for the icons of the buttons: 
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If you want to place the toolbar in Float templates on the top of the flash eBook, you can set 

If you want to add some other kinds of buttons which the program doesn't provide, you can click 

" to enter into "Icons Settings" interface to add new icons on tool bar: 

define the link action as "Go to page", or open an online webpage, or even "Call 

Javascript function" to carry out your wanted interactive functionalities via defining Javascript 

n the toolbar. (More 

->Add Link".) 
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i. Icon Color  

 

ii. Icon File 

Select the Tool Bar Button to replace with your own icon. 

More details please view here: 

http://www.flashcatalogmaker

book.html 

3. Flash Display Settings 

 

(1) Retain the book to center

If you select “No” in this option, the eBook will be shown on the right

embedding special background image, such as advertisement or company log.

 

(2) Font 

If you want to change fonts of toolbar buttons, flash windows even bookmark

result panel, you can set font types and colors in Font Panel. 
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Select the Tool Bar Button to replace with your own icon.  

 

More details please view here:  

flashcatalogmaker.com/faq/replace-the-icons-on-the-toolbar-of-flash

 

 

) Retain the book to center 

 

you select “No” in this option, the eBook will be shown on the right-side. This setting is for 

embedding special background image, such as advertisement or company log.

 

to change fonts of toolbar buttons, flash windows even bookmark

result panel, you can set font types and colors in Font Panel.  
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flash-page-flipping-

side. This setting is for 

embedding special background image, such as advertisement or company log. 

to change fonts of toolbar buttons, flash windows even bookmarks or search 
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(3) Initial Show (set in Float/ Spread templates)

You can show Bookmark panel or Thumbnails panel on the flash page at the beginning, just 

select "Bookmark" or "Thumbnails" in 

For Example, select "Thumbnails":

Then you will get flipbook shown with below initial interface:

 

(4) Background Config 

i. Background Color:  

Define background for your flipbook with gradient color or pure color (the same color for 

"Gradient Color A" and "Gradient Color B"). Gradient Angle is the angle between two colors.
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(set in Float/ Spread templates) 

You can show Bookmark panel or Thumbnails panel on the flash page at the beginning, just 

select "Bookmark" or "Thumbnails" in this option: 

For Example, select "Thumbnails":  

Then you will get flipbook shown with below initial interface: 

 

 

Define background for your flipbook with gradient color or pure color (the same color for 

"Gradient Color A" and "Gradient Color B"). Gradient Angle is the angle between two colors.
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You can show Bookmark panel or Thumbnails panel on the flash page at the beginning, just 

 

Define background for your flipbook with gradient color or pure color (the same color for 

"Gradient Color A" and "Gradient Color B"). Gradient Angle is the angle between two colors. 
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ii. Background Image (set in Classical and Spread templates

Click the icon " " to choose background image from your computer, and there are 11 kinds 

of "Image Position" for you to choose: Scale to fit, Fill, Top Left, Top Center, Top Right, 

Middle Left, Middle Center, Middle Right, Bottom Left, Bottom Center and Bottom Right. 

iii. Background Image (set in Float template

The Float template enables you to add two background images: Outer Image and Inner 

Image. You can make Inner background image to show special information, such as 

advertisement or company logo, etc. 

choose: Scale to fit, Fill, Top Left, Top Center, Top Right, Middle Left, Middle Center, Middle 

Right, Bottom Left, Bottom Center and Bottom Right

 

(7) Flash Window Color 

This color will be applied on all flash windows, such as the book window, "Help" 

"Print" window and so on. 
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in Classical and Spread templates): 

 

" to choose background image from your computer, and there are 11 kinds 

osition" for you to choose: Scale to fit, Fill, Top Left, Top Center, Top Right, 

Middle Left, Middle Center, Middle Right, Bottom Left, Bottom Center and Bottom Right. 

in Float template): 

 
The Float template enables you to add two background images: Outer Image and Inner 

Image. You can make Inner background image to show special information, such as 

advertisement or company logo, etc. There are also 11 kinds of "Image Position" for you to 

oose: Scale to fit, Fill, Top Left, Top Center, Top Right, Middle Left, Middle Center, Middle 

Right, Bottom Left, Bottom Center and Bottom Right. 

 

This color will be applied on all flash windows, such as the book window, "Help" 
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" to choose background image from your computer, and there are 11 kinds 

osition" for you to choose: Scale to fit, Fill, Top Left, Top Center, Top Right, 

Middle Left, Middle Center, Middle Right, Bottom Left, Bottom Center and Bottom Right.  

The Float template enables you to add two background images: Outer Image and Inner 

Image. You can make Inner background image to show special information, such as 

There are also 11 kinds of "Image Position" for you to 

oose: Scale to fit, Fill, Top Left, Top Center, Top Right, Middle Left, Middle Center, Middle 

This color will be applied on all flash windows, such as the book window, "Help" window, 
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(8) Page Background Color 

When load pages, or if the page number of your 

will show with the "Page Background Color".

 

(9) Book Proportions 

Please note that the values are

"Page Width: Page Height", and the book size will be changed depend on your Explorer 

Window Size. 

 

(10) Book Margins 

i. Book Margin (set in Classical Template):

"Book Margin" refers to the 
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When load pages, or if the page number of your PPT file is odd, then the page (the last page) 

will show with the "Page Background Color". 

 

Please note that the values are not fixed in pixels or inches, they just represent a ratio for 

"Page Width: Page Height", and the book size will be changed depend on your Explorer 

. Book Margin (set in Classical Template): 

 
"Book Margin" refers to the distance between the book and the toolbar. 
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file is odd, then the page (the last page) 

not fixed in pixels or inches, they just represent a ratio for 

"Page Width: Page Height", and the book size will be changed depend on your Explorer 
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ii. Top/ Bottom/ Left/ Right Margin (set in Float/ Spread Template):

 

(11) Page Shadow 

The value also takes the value of Book Proportions as reference, and the value interval of 

"Page Shadow Opacity" is "0~1",

 

(12) Hide Book Frame Bar 

If don’t want to show the book frame bar, choose “Yes” in this option.

 

(13) Right to Left 

If the language of your file is read from right to left (such as Arabic), then 

"Right to Left" option: 
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. Top/ Bottom/ Left/ Right Margin (set in Float/ Spread Template): 

 

 

The value also takes the value of Book Proportions as reference, and the value interval of 

"Page Shadow Opacity" is "0~1", the larger value refers to the deeper shadow color.

 

 

If don’t want to show the book frame bar, choose “Yes” in this option. 

If the language of your file is read from right to left (such as Arabic), then 
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The value also takes the value of Book Proportions as reference, and the value interval of 

the larger value refers to the deeper shadow color. 

If the language of your file is read from right to left (such as Arabic), then choose "Yes" in 



PPT to Flash Catalog 

Copyright 201

 

(14) Hard Cover 

If you want create hard cover effect (a book bound with rigid protective covers) for your 

flipbook, choose "Yes" in "Hard Cover" option:

 

(15) Flipping time 

Sets page flipping time in seconds 

 

(16) Page Number 

If you don't want to count in the cover page, table of contents pages into the actual page 

numbers, you can set "Start Page Numbering (Roman)" and "Start Page Numbering (Arabic)". 

For example, the first 3 pages are Table of Content pages with Roman page numbers, and 

set Arabic page numbers from page 4, then you will get page number box like below:

 

(17) Minime Style 

If you want to present Page-

when you want to embed eBook into a small area in existing webpages

"Minime Style".  

 

The Minime Style will trigger when the Width or Height of the Flash Container is less than the 

defined value. You can also always show the page

parameter to your URL like this: www.yourdomain.com/index.html?alwaysMinimeStyle=true .
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If you want create hard cover effect (a book bound with rigid protective covers) for your 

flipbook, choose "Yes" in "Hard Cover" option: 

 

 

Sets page flipping time in seconds according to your needs. (Recommended value is 0.6)

If you don't want to count in the cover page, table of contents pages into the actual page 

numbers, you can set "Start Page Numbering (Roman)" and "Start Page Numbering (Arabic)". 

ample, the first 3 pages are Table of Content pages with Roman page numbers, and 

set Arabic page numbers from page 4, then you will get page number box like below:

 

-flipping eBook pages directly without showing toolbar

embed eBook into a small area in existing webpages, then you can use this 

The Minime Style will trigger when the Width or Height of the Flash Container is less than the 

always show the page-flipping eBook in Minime Style with adding a 

parameter to your URL like this: www.yourdomain.com/index.html?alwaysMinimeStyle=true .
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If you want create hard cover effect (a book bound with rigid protective covers) for your 

according to your needs. (Recommended value is 0.6) 

If you don't want to count in the cover page, table of contents pages into the actual page 

numbers, you can set "Start Page Numbering (Roman)" and "Start Page Numbering (Arabic)". 

ample, the first 3 pages are Table of Content pages with Roman page numbers, and 

set Arabic page numbers from page 4, then you will get page number box like below: 

ng toolbar, especially 

, then you can use this 

The Minime Style will trigger when the Width or Height of the Flash Container is less than the 

flipping eBook in Minime Style with adding a 

parameter to your URL like this: www.yourdomain.com/index.html?alwaysMinimeStyle=true . 
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4. Flash Control Settings 

 

(1). Security Settings 

If you want to protect your flash books with 

"Flash Security Config" interface:

Select "Security Type->Single Password", and input passwords into the box (there is no 

restriction on password format at present). You can also set "Protect Page Range" as

Pages" or the latter pages after a defined page number. (Tips: The program utilize RC4 

algorithm to protect eBook pages, the eBook content pages will show nothing without 

permission.) 
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If you want to protect your flash books with passwords, you can click "…" icon to enter into 

"Flash Security Config" interface: 

 

>Single Password", and input passwords into the box (there is no 

restriction on password format at present). You can also set "Protect Page Range" as

Pages" or the latter pages after a defined page number. (Tips: The program utilize RC4 

algorithm to protect eBook pages, the eBook content pages will show nothing without 

Flipping eBook Utility 

User Document 

passwords, you can click "…" icon to enter into 

>Single Password", and input passwords into the box (there is no 

restriction on password format at present). You can also set "Protect Page Range" as "All 

Pages" or the latter pages after a defined page number. (Tips: The program utilize RC4 

algorithm to protect eBook pages, the eBook content pages will show nothing without 
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(2). Links 

If you have check "Import links" option in "Import 

interface, then you can define settings here, choose "Mouse over color", "Link alpha" (refers 

to the link area opacity, value interval: 0~1, "0" stands for the area is totally transparent

and "Open Window->Blank/ Self".

"Enable after Zooming in->Enable".

 

(3). Google Analytics  

In the HTML output format, you can add statistics by using google analytics. You can get 

more information about Google Analyti

 

Besides, Export Theme 

 

If you want to save the current template settings as your own style template for later uses, 

you can click "File->Export current settings

settings, include the background images, margin values, toolbar buttons and so on.

Then when you want to use later, just click "File

to the templates selecting inter

 

Download more themes from 

http://www.flashcatalogmaker

 

 

After setting template and language

apply the settings. 
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If you have check "Import links" option in "Import PPT" interface, or add links in "Edit Page" 

then you can define settings here, choose "Mouse over color", "Link alpha" (refers 

to the link area opacity, value interval: 0~1, "0" stands for the area is totally transparent

Blank/ Self". The links also can be clicked after zooming by setting 

>Enable". 

 

In the HTML output format, you can add statistics by using google analytics. You can get 

more information about Google Analytics ID from http://www.google.com/analytics/

If you want to save the current template settings as your own style template for later uses, 

current settings as Theme" button to storing all current template 

the background images, margin values, toolbar buttons and so on.

Then when you want to use later, just click "File->Import Themes", the theme will be added 

to the templates selecting interface. 

Download more themes from Flashcatalogmaker now: 

flashcatalogmaker.com/alpha-templates.html. 

fter setting template and language, click 
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or add links in "Edit Page" 

then you can define settings here, choose "Mouse over color", "Link alpha" (refers 

to the link area opacity, value interval: 0~1, "0" stands for the area is totally transparent), 

The links also can be clicked after zooming by setting 

In the HTML output format, you can add statistics by using google analytics. You can get 

http://www.google.com/analytics/ . 

If you want to save the current template settings as your own style template for later uses, 

Theme" button to storing all current template 

the background images, margin values, toolbar buttons and so on. 

>Import Themes", the theme will be added 

 icon to 
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III. Edit Pages 

Use PPT to Flash Catalog  Pro

video, sound or image file. C

interface: 

 

1. Add Link 

Click the icon  and then draw a link box 

properties in below panel: 
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Pro to edit imported pages directly, no matter you want to add link, 

Click "Edit Pages" button  to enter into 

and then draw a link box on the area you want to add link, then define 

Flipping eBook Utility 
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edit imported pages directly, no matter you want to add link, 

nter into page edit 

 

area you want to add link, then define 
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You can define the link action as "Go to page", or open an online webpage, or eve

Javascript function" to carry out your 

function yourself.. For example, 

image on page, or pop-up a questionnaire or other Web Form by clicking some text.

sure the parameter you set in "Function" can be called in from HTML pag

 

Example: Check "Call Javascript function" as action type, then input Function as 

"testLightBox("Hello, this is a test"):

 

 

And then make sure the Javascript wrote into the index.html page as below image shows (the 

same as you set in "Link Function"):
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You can define the link action as "Go to page", or open an online webpage, or eve

to carry out your wanted interactive functionalities via defining Javascript 

. For example, you can show a pop-up light box while readers clicking some 

up a questionnaire or other Web Form by clicking some text.

sure the parameter you set in "Function" can be called in from HTML page. 

Check "Call Javascript function" as action type, then input Function as 

"testLightBox("Hello, this is a test"): 

And then make sure the Javascript wrote into the index.html page as below image shows (the 

same as you set in "Link Function"): 

Flipping eBook Utility 
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You can define the link action as "Go to page", or open an online webpage, or even "Call 

via defining Javascript 

readers clicking some 

up a questionnaire or other Web Form by clicking some text. Just make 

Check "Call Javascript function" as action type, then input Function as 

 

And then make sure the Javascript wrote into the index.html page as below image shows (the 
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2. Add Movie 

 

Click icon  and then draw a box like below on the page you want to insert FLV movie:

 

Then you can select and edit the movie in below panel

stop movie actions, etc.): 

 

3. Add Image 
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and then draw a box like below on the page you want to insert FLV movie:

Then you can select and edit the movie in below panel (define video player skin color, play and 
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and then draw a box like below on the page you want to insert FLV movie: 

(define video player skin color, play and 
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Click the icon  to draw 

Options (the same as Link Action Options)

 

 

4. Add Sound 

 

Click the icon  to draw sound box and then 

 

5. Add Flash 

 

Click icon  to insert SWF flash into your defined area of flipbook page:
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to draw image box and then select image (.jpg, .png, .bmp

(the same as Link Action Options): 

draw sound box and then select sound file, set other options:

 

SWF flash into your defined area of flipbook page: 

Flipping eBook Utility 
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.bmp), set Action 

 

set other options: 
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6. Add Button 

 

Click icon  to draw an area for inserting your image or SWF button file with calling actions

The actions contain "Go to page", "Open a link", "Call Javascript function" a

Window". The before three actions are the same with the actions in "Add Link", the "Open Flash 

Window" can help you to play SWF Flash or FLV Video in the pop

 

 

7. Add You Tube Video 

Click the icon and then draw a box on the page 

You just need to define the video ID directly. For example the video link is: 

http://www.youtube.com/watch?v=xKA6WIqjB7c
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to draw an area for inserting your image or SWF button file with calling actions

The actions contain "Go to page", "Open a link", "Call Javascript function" a

Window". The before three actions are the same with the actions in "Add Link", the "Open Flash 

Window" can help you to play SWF Flash or FLV Video in the pop-up window: 

and then draw a box on the page to insert You Tube video into pages directly. 

You just need to define the video ID directly. For example the video link is: 

http://www.youtube.com/watch?v=xKA6WIqjB7c, then the video ID is " xKA6WIqjB7c

Flipping eBook Utility 
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to draw an area for inserting your image or SWF button file with calling actions. 

The actions contain "Go to page", "Open a link", "Call Javascript function" and "Open Flash 

Window". The before three actions are the same with the actions in "Add Link", the "Open Flash 

 

You Tube video into pages directly. 

You just need to define the video ID directly. For example the video link is: 

xKA6WIqjB7c".  
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8. Add Printable Area 

If you want readers can click on some area of your book to print the area directly, such as 

coupons which can be used to buy your presented goods, you can add a "Printable Area" on 

pages by clicking the icon

 

9. Copy and Paste  

If you want to add same links, images, videos, audios to different pages, you don't have to repeat 

the "Link/Image/Video/Audio added" operations once and once again, just select the link object, 

click the copy button and then go to the other page to click

 

10. Apply All 

If you want to use the same link, video, audio, image 
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If you want readers can click on some area of your book to print the area directly, such as 

coupons which can be used to buy your presented goods, you can add a "Printable Area" on 

, and then draw the area on the pages, set title and description

 

If you want to add same links, images, videos, audios to different pages, you don't have to repeat 

the "Link/Image/Video/Audio added" operations once and once again, just select the link object, 

and then go to the other page to click the paste button 

If you want to use the same link, video, audio, image or button on all pages (or all odd, even 
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If you want readers can click on some area of your book to print the area directly, such as 

coupons which can be used to buy your presented goods, you can add a "Printable Area" on 

, set title and description: 

If you want to add same links, images, videos, audios to different pages, you don't have to repeat 

the "Link/Image/Video/Audio added" operations once and once again, just select the link object, 

the paste button directly. 

or button on all pages (or all odd, even 
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pages, or your customized pages), you can select the object and then click the Apply All button

, then define the apply page range in pop

 

After adding links, flash, movie or sounds, you can click the icon

back to the template setting interface.
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pages, or your customized pages), you can select the object and then click the Apply All button

ly page range in pop-up window like below: 

 

After adding links, flash, movie or sounds, you can click the icon  to save the settings and 

back to the template setting interface. 
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pages, or your customized pages), you can select the object and then click the Apply All button

to save the settings and 
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IV. Output Interface

 

1. HTML 

 

This output type is for uploading created 

 

You can define HTML Title and other properties by clicking "Advanced" button: 

 

 

Set Keywords, Description or even Script in the below interface:
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Output Interface 

This output type is for uploading created page-flipping ebook onto websites:

You can define HTML Title and other properties by clicking "Advanced" button: 

  

Set Keywords, Description or even Script in the below interface: 

Flipping eBook Utility 
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flipping ebook onto websites: 

You can define HTML Title and other properties by clicking "Advanced" button:  
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2. ZIP 

 
 

This output type is for compressing the created files into

be sending out as attachment directly. You can also define HTML Advanced Settings by 

clicking "Advanced" icon:

 

Your recipients just need to uncompress the ZIP file and then they can view the HTML 

flipbook instantly: 

 

3. EXE 

 

This type is for outputting flipbook as a single executive file, easy storing and easy viewing: 

 

You can also define Icon and Opening Window Size in Advanced Settings:
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This output type is for compressing the created files into an integral ZIP package which can 

be sending out as attachment directly. You can also define HTML Advanced Settings by 

 

Your recipients just need to uncompress the ZIP file and then they can view the HTML 

 

type is for outputting flipbook as a single executive file, easy storing and easy viewing: 

You can also define Icon and Opening Window Size in Advanced Settings: 
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an integral ZIP package which can 

be sending out as attachment directly. You can also define HTML Advanced Settings by 

Your recipients just need to uncompress the ZIP file and then they can view the HTML 

type is for outputting flipbook as a single executive file, easy storing and easy viewing:  
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4. APP 

 

If you want to make executable 

"*.app" format. 

 

5. Mobile Version 

You can even output Mobile Version while choosing HTML or ZIP format at the same time

And you can set Mobile Version quality and template in "Options

(1) Pages Quality and Size 

Five types of "Pages Quality And Size"

 

(2) Mobile Template 

The current version provides two mobile template modes for you to use: Slide and 

Single Page Flip. The later one adds page

in mobiles.  

 

After creating mobile versions, you just need to output all files online (including HTML, SWF, 

"files" and "mobile" folders), then you can visit the flipbook page through your mobile 

browser.  
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If you want to make executable application to run on Mac devices, you can output as 

 

You can even output Mobile Version while choosing HTML or ZIP format at the same time

And you can set Mobile Version quality and template in "Options->Application Options":

 

Quality And Size" for mobile version eBooks: 

 

The current version provides two mobile template modes for you to use: Slide and 

Single Page Flip. The later one adds page-flipping effect on the pages while viewing 

After creating mobile versions, you just need to output all files online (including HTML, SWF, 

"files" and "mobile" folders), then you can visit the flipbook page through your mobile 

Flipping eBook Utility 

User Document 

to run on Mac devices, you can output as 

You can even output Mobile Version while choosing HTML or ZIP format at the same time. 

>Application Options": 

The current version provides two mobile template modes for you to use: Slide and 

he pages while viewing 

After creating mobile versions, you just need to output all files online (including HTML, SWF, 

"files" and "mobile" folders), then you can visit the flipbook page through your mobile 
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6. Burn to CD 

 

 

After choosing output type, then check the option "Burn to CD", set "CD Writer", define 

"Disc title". 

 

How to make created eBooks available for others online, 

http://www.flashcatalogmaker

 

At last click 

 

V. Batch Convert Interface
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choosing output type, then check the option "Burn to CD", set "CD Writer", define 

How to make created eBooks available for others online, more details this 

maker.com/faq/do-you-plan-to-share-flipping-ebook

button to output flipbook in your defined type.

Convert Interface 

Flipping eBook Utility 

User Document 

choosing output type, then check the option "Burn to CD", set "CD Writer", define 

this support page: 

ebook-online.html. 

button to output flipbook in your defined type. 
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1. Add PPT Documents 

Click this icon to add PPT

 Click this icon to add all 

You can also remove some unwanted 

 

2. Settings 

(1). Output Settings 

  i. Choose Output Type 

  ii. Choose Output Path 

 

 

You can also define output name pattern with FileName, Title, Subject and so on:

 

And after defining the File Name, you can preview the result example below:

 

  iii. Define Output Option 

Click "Advanced" icon to define Keywords, Description for HTML flipbooks, or define Icon, 

Window Size for EXE flipbooks:

PPT to Flash Catalog  Professional Flipping eBook Utility

User Document

Copyright 2012 by flashcatalogmaker.com 

- 37 - 

PPT files from computer; 

Click this icon to add all PPT files in the folder (include sub-folders).

You can also remove some unwanted PPT, move up/ down files, or clear all documents. 

 

 

 

You can also define output name pattern with FileName, Title, Subject and so on:

 

And after defining the File Name, you can preview the result example below:

 

 

 

Click "Advanced" icon to define Keywords, Description for HTML flipbooks, or define Icon, 

Window Size for EXE flipbooks: 

Flipping eBook Utility 

User Document 

folders). 

documents.  

You can also define output name pattern with FileName, Title, Subject and so on: 

And after defining the File Name, you can preview the result example below: 

Click "Advanced" icon to define Keywords, Description for HTML flipbooks, or define Icon, 
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(2). PPT Settings 

  i. Page Range 

 

You can convert "All pages" or just "Custom range";

  ii. File Mode 

  iii. Page Quality 

Choose quality and size type from listed five kinds.

  iv. Other Options 

Check this option to 

If your PPT 

Check this option to enable search functionality in created flipbook.

 

At last, click 
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You can convert "All pages" or just "Custom range"; 

 

 

Choose quality and size type from listed five kinds. 

heck this option to import bookmarks from original PPT files;

 file has links, check this to enable in flipbook; 

Check this option to enable search functionality in created flipbook.

 icon to batch convert listed files together.

Flipping eBook Utility 

User Document 

 

import bookmarks from original PPT files; 

Check this option to enable search functionality in created flipbook. 

icon to batch convert listed files together. 
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License Agreements

 

All copyrights to PPT to Flash Catalog 

Flashcatalogmaker.com. For more information, visit our website at 

www.Flashcatalogmaker.com

 

Anyone may use this software but all the page

have a demo watermark on the first page of them. To remove the limitation you must 

register. 

 

Once registered, the user is granted a non

computer (i.e. a single CPU) at a time. The registered Software may 

but may be permanently transferred, if the person receiving it agrees to terms of this 

license.  

 

The Software unregistered (trial) version may be freely distributed, provided the distribution 

package is not modified. No person or 

Software without written permission from the copyright holder. 

 

THE SOFTWARE IS DISTRIBUTED "AS IS". NO WARRANTY OF ANY KIND IS EXPRESSED OR 

IMPLIED. YOU USE AT YOUR OWN RISK. THE AUTHOR WILL NOT BE LIA

DAMAGES, LOSS OF PROFITS OR ANY OTHER KIND OF LOSS WHILE USING OR MISUSING THIS 

SOFTWARE. 

 

You may not use, copy, emulate, clone, rent, lease, sell, modify, decompile, disassemble, 

otherwise reverse engineer, or transfer the licensed Sof

Software, except as provided for in this agreement. Any such 

immediate and automatic termination of this license and may result in criminal and/or civil 

prosecution. 

 

All rights not expressly granted here are reserved by A

 

Installing and using the Software signifies acceptance of these terms and conditions of the 

license. 

 

If you do not agree with the terms of this license you must remove the Software files from 

your storage devices and cease to use the product.
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License Agreements   

PPT to Flash Catalog  Pro (the Software) are exclusively owned by 

.com. For more information, visit our website at 

.com . 

Anyone may use this software but all the page-flipping eBooks generated will automati

have a demo watermark on the first page of them. To remove the limitation you must 

Once registered, the user is granted a non-exclusive license to use the Software on one 

computer (i.e. a single CPU) at a time. The registered Software may not be rented or leased, 

but may be permanently transferred, if the person receiving it agrees to terms of this 

The Software unregistered (trial) version may be freely distributed, provided the distribution 

package is not modified. No person or company may charge a fee for the distribution of the 

Software without written permission from the copyright holder.  

THE SOFTWARE IS DISTRIBUTED "AS IS". NO WARRANTY OF ANY KIND IS EXPRESSED OR 

IMPLIED. YOU USE AT YOUR OWN RISK. THE AUTHOR WILL NOT BE LIABLE FOR DATA LOSS, 

DAMAGES, LOSS OF PROFITS OR ANY OTHER KIND OF LOSS WHILE USING OR MISUSING THIS 

You may not use, copy, emulate, clone, rent, lease, sell, modify, decompile, disassemble, 

otherwise reverse engineer, or transfer the licensed Software, or any subset of the licensed 

Software, except as provided for in this agreement. Any such unauthorized use shall result in 

immediate and automatic termination of this license and may result in criminal and/or civil 

essly granted here are reserved by A-PPT Solution. 

Installing and using the Software signifies acceptance of these terms and conditions of the 

If you do not agree with the terms of this license you must remove the Software files from 

e devices and cease to use the product. 

Flipping eBook Utility 

User Document 

(the Software) are exclusively owned by 

flipping eBooks generated will automatically 

have a demo watermark on the first page of them. To remove the limitation you must 

exclusive license to use the Software on one 

not be rented or leased, 

but may be permanently transferred, if the person receiving it agrees to terms of this 

The Software unregistered (trial) version may be freely distributed, provided the distribution 

company may charge a fee for the distribution of the 

THE SOFTWARE IS DISTRIBUTED "AS IS". NO WARRANTY OF ANY KIND IS EXPRESSED OR 

BLE FOR DATA LOSS, 

DAMAGES, LOSS OF PROFITS OR ANY OTHER KIND OF LOSS WHILE USING OR MISUSING THIS 

You may not use, copy, emulate, clone, rent, lease, sell, modify, decompile, disassemble, 

tware, or any subset of the licensed 

use shall result in 

immediate and automatic termination of this license and may result in criminal and/or civil 

Installing and using the Software signifies acceptance of these terms and conditions of the 

If you do not agree with the terms of this license you must remove the Software files from 
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How to Order 

 

Order Online (http://www.

Order Toll Free 1-877-353-7297

number of the product you would like

 

How to purchase online?  

 

1. Select a license type above, and click [Buy Now]

 

2. Select the currency that you want to 

 

3. Fill billing information and select a payment method. 

 

4. Check the information you filled previously and click "Place Secure Order" 

 

Other Order Ways—With Phone/Mail/Fax/Check:

 

If you are not comfortable ordering online with

offline order option in the payment section of the order process. We accept mail, fax, wire, 

and PO (if applicable) ordering options in addition to ordering online. We also provide 

phone orders through our 24x

International Callers.  

 

Please note that all of the offline orde

place an order by mail, fax, wire, and

choose one of these payment options found in the Payment Method sec

Once submitted online, the appropriate information will be provide

browser to send your payment to us offline.

 

100% unconditional 30 Day Money Back Guarantee

 

 

Want to custom the program or have other questions about 

Contact us at support@flashcatalogmaker
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http://www.flashcatalogmaker.com/ppt-to-flippingbook-pro

7297 (When you order toll free just give the operator the product 

would like). 

 

a license type above, and click [Buy Now] 

the currency that you want to use. (You can also continue shopping)

and select a payment method. (Your information is safe 

4. Check the information you filled previously and click "Place Secure Order" 

With Phone/Mail/Fax/Check: 

If you are not comfortable ordering online with a credit card, you are welcome to choose an 

ayment section of the order process. We accept mail, fax, wire, 

(if applicable) ordering options in addition to ordering online. We also provide 

phone orders through our 24x7 order desk at 1-877-353-7297, or (952) 646-5331 for 

offline ordering options do have additional fees for processing. To 

place an order by mail, fax, wire, and PO (when applicable), use the online form and then 

choose one of these payment options found in the Payment Method section of the form. 

Once submitted online, the appropriate information will be provided to you in your web 

send your payment to us offline. 

100% unconditional 30 Day Money Back Guarantee 

Want to custom the program or have other questions about purchase? 

flashcatalogmaker.com . 

Flipping eBook Utility 
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pro/index.html) or 

When you order toll free just give the operator the product 

use. (You can also continue shopping) 

Your information is safe with us) 

4. Check the information you filled previously and click "Place Secure Order"  

a credit card, you are welcome to choose an 

ayment section of the order process. We accept mail, fax, wire, 

(if applicable) ordering options in addition to ordering online. We also provide 

5331 for 

fees for processing. To 

PO (when applicable), use the online form and then 

tion of the form. 

d to you in your web 
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Support 

You can easily search or browse our frequently asked questions, and learn tutorials about 

products, and get your registration code back. If you 

provided, please contact support team for help.

 

1. Frequently Asked Questions

You can find answers to question

http://www.flashcatalogmaker

 

2. Get lost license code

Click here to look up the order » (

You can pull up a copy of your order by entering your email address. After you find your 

order, you may view its status, view deta

obtain the invoice.  

 

3. Contact Us  

If you have other questions or requirements, contact us directly through our support Email: 

support@flashcatalogmaker.com
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You can easily search or browse our frequently asked questions, and learn tutorials about 

products, and get your registration code back. If you are not satisfy with the solution

, please contact support team for help. 

1. Frequently Asked Questions 

You can find answers to questions about technique issues here: 

flashcatalogmaker.com/faq.html 

2. Get lost license code 

Click here to look up the order » (http://www.regnow.com/cs/orderStatus) 

You can pull up a copy of your order by entering your email address. After you find your 

order, you may view its status, view details of your order (including the license key), and 

If you have other questions or requirements, contact us directly through our support Email: 

flashcatalogmaker.com, we will respond you ASAP. 

Flipping eBook Utility 
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You can easily search or browse our frequently asked questions, and learn tutorials about 

solutions 

 

You can pull up a copy of your order by entering your email address. After you find your 

ils of your order (including the license key), and 

If you have other questions or requirements, contact us directly through our support Email: 
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